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1 S7 for Windows® Basics 

To work with S7 for Windows® basic skills are necessary.  

1.1 Opening the S7 for Windows® Software 

During the installation of S7 for Windows® an icon has been 
inserted. Double click the icon “S7 for Windows®” to start the 
programming system. 

 

1.2 S7 for Windows® Basic Window  
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Title Bar 

 

The title bar displays S7 for Windows®, and, if an additional Window 
is open in the workplace, the name of the open window is also 
displayed. The Icons are “Windows” specific.  
 

Open Control menu 
This icon opens the Control menu that contains the commands to 
Restore, Move, Size, Minimize, Maximize, or Close the open 
Window. The Keyboard shortcut is Alt + Spacebar. 

 

Minimizing the open window to an icon 
Clicking the button at the right side of the S7 for Windows® title 
reduces the open window to the size of an icon (same function as 
the Minimize command from the Control menu). 

 

Maximizing the open window 
Clicking the Maximize button in the upper right corner of S7 for 
Windows® will enlarge the window to its maximum size (same 
function as the Maximize command from the Control menu).  

 

Restoring an enlarged window to its previous size  
Clicking the Restore button in the upper right corner of S7 for 
Windows® will restore an enlarged window to its previous size 
(same function as the Restore command from the Control menu). 

 

Closing S7 for Windows  
Clicking the Close button in the upper right corner of S7 for 
Windows® will terminate S5 for Windows (same function as the 
Close command from the Control menu). 

Menu Bar 

 
The menu bar lists the available menus. The menus contain the 
available commands of S7 for Windows®. The menus in the menu 
bar change depending on the S7 for Windows® application windows 
opened. You can open a menu by clicking the name of the menu or 
by pressing the ALT key and then the first Letter of the menu name.   
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Tool Bar I  

The tool bar provides instant access to frequently used  
S7 for Windows® commands. Click an icon with the mouse and the 
command is executed. You can reach these functions with the 
keyboard via the window menu and/or the function keys. The number 
of the icons to open windows depends on the selection “Classic 
Operator Interface” ON/OFF. 

This tool bar is the same for all S7 for Windows® application 
windows. 

Tool Bar I – Standard Operator Interface (Classic operator interface OFF) 

 
 

Tool Bar I – Classic Operator Interface (Classic operator interface ON) 

 

Tabs 
Several “tabs” may be displayed at the 
left as well as at the button of the S7 for 
Windows® window. The “Tabs” 
displayed depend on the selected 
windows in the “View” menu. 

Workplace 
All the blocks of an open PLC program file are listed in the PC block 
List. Additional application windows fill out the workplace. 

Workplace Column Title Bar 

 

Clicking the title of a column will sort the PC Block List information in 
an ascending order. Clicking the title again will sort the information in 
a descending order. 

The column width can be adjusted by dragging the column border 
with the mouse. 

Status Bar 

 
The status bar may displays additional information on the open 
window and executed tasks.  
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1.3 Operator Interface mode. 

Version 6.x of S7 for Windows® has a new concept for opening and 
closing windows in the workplace. 

Classic Operator Interface 

If the “Classic operator interface” mode is selected, the “Tool Bar I” is 
extended and the open windows will stay open until they are closed. 

To select the previously described mode, click “Classic operator 
interface” in the “Window” menu. 

 

In “Classic operator interface” mode the “PC Block List” window is 
open and fills the whole workplace. 

Using the “Auto Hide” functions. 
It is recommended that you use the “Auto Hide” icon to lock the tab at 
the outside border of S7 for Windows®. By bringing the mouse 
pointer to the tab, the window will open automatically. 

Use the “Auto Hide” icon to close a window. 

             

Note: 

The right mouse button may be used within the Workplace.  

If the right mouse button is clicked, a menu with the most important 
commands is opened. 
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“Auto Hide” function to close the “Offline tree” and the “Online tree” 

 

Operator Interface mode. 
You can use the “Auto Hide” icon to lock the tab at the outside border 
of the workplace. By moving the mouse pointer to the tab, the 
window will open automatically. As soon as the mouse pointer leaves 
the automatically opened window, the window is closed. 

If you click at tab, the open window will stay open until it is closed. 

You can use the “Auto Hide” icon to lock the tab at the outside border 
of the workplace. By moving the mouse pointer to the tab, the 
window will open automatically. As soon as the mouse pointer leaves 
the automatically opened window, the window is closed. 

If you click the tab the opened window will stay open until it is closed. 

You may select the “Window Position. 
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1.4 Recommend Settings  

 
 

Close all unnecessary windows. 
Open the “View” menu and select the “Offline tree” and “Online 
tree”. Deselect all other views. 

The “View” menu is used to select the necessary windows. 

 

The “Offline tree” is used to select the “S7 Project” that you 
want to work with. The S7 Project contains the files necessary for 
an S7 PLC program. Later, we will show you how to generate a n S7 
Project will be explained. An S7 Project is always required to work 
with a S7 PLC program executed on a PLC. 

The “Online tree” is used to select the PLC to be connected 
with.  

Note: 
We recommend that you use S7 for Windows® with the “Standard 
operator interface” (Classic Operator Interface” OFF – see chapter 1.3). 
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Tool Bar I  
Depending on the selection, ON/OFF, the “Classic Operator 
Interface” or the Standard Operator Interface will be used. 

Classic Operator Interface 

 

The tool bar provides instant access to frequently used S7 for 
Windows® commands. Click an icon with the mouse and the 
command is executed. You can reach these functions with the 
keyboard via the window menu and/or the function keys. 

This tool bar is the same for all S7 for Windows® application 
windows (Classic operator interface mode). 
 

Tool Bar I – Standard Operator Interface (Classic Operator Interface OFF) 

 
 

 

PLC Error Display (I-Stack, B-Stack, 
Diagnostic Buffer) 
This icon enables you to view the program interrupt information 
stored in the PLC (I-Stack, B-Stack, Diagnostic Buffer). The 
information is displayed in real language with the faulty portion of 
the program. 

 

Go to previous Window 
(Classic Operator Interface – ON only) 
This icon allows you to switch rapidly between open windows 
with a mouse click. The keyboard shortcut Ctrl+F6 provides the 
same function. 

 

Display the Offline Block List  
(Classic Operator Interface – ON only) 
This index lists all the blocks with the date and time it was 
created or changed and a comment. One or more blocks may be 
selected for further manipulation. 

 

Display the Online Block List 
(Classic Operator Interface – ON only) 
This index lists all the blocks stored in the PLC. One or more 
blocks may be selected for further manipulation in the same way 
it is handled in the windows file manager. 
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EPROM / EEPROM / Flash 
EPROM Burner 
This icon opens a menu to control EPROM / EEPROM / Flash 
EPROM burning.  
 

Cross Reference Display 
A click on this icon lists the appearance 
of operands, as a  symbol or absolute, throughout the whole 
program. This function may be called from any window.  

Block Edit 
The block selected in the block 
listing will be displayed in the block editor and is ready for any 
changes. The keyboard shortcut F10 provides the same function. 

Symbolic Table Editor 
With this easy to use integrated editor you 
can write, cut, copy and paste text to create and modify the 
symbol table. The symbol table may be tested for multiple uses 
of addresses or symbols. The symbol table can also be sorted 
by addresses or symbols.  

On-line PLC Status 
The status of flags, inputs, outputs, 
timers, counters, comparators, data words, and peripheral words 
are displayed and can be modified. 

Oscilloscope 
The Oscilloscope allows the observation of 
several operands (signals) inside the PLC changing their value 
over the time. 

Preferences 
This icon opens dialog boxes to 
customize the appearance of  
S7 for Windows®. The settings for the serial port, the editors, the 
indexes, the display font and other (miscellaneous) settings are 
saved and are reloaded whenever a new PLC project is opened. 

PLC Block (Program) 
Compare 
S7 for Windows® offers a powerful PLC Program (Block 
Compare). The command Compare opens dialog boxes to 
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select PLC Program files to compare (online and offline). 

 

S7 Hardware configuration 
This icon opens a window to setup and change the Hardware 
configuration of the S7 PLC. 

 

Dynamic PLC Block Display 
Enables fast switching between open PLC status windows. 

 

Closing Open Windows 
The S7 for Windows® active window is closed by clicking this 
icon. The keyboard shortcut Ctrl+F4 provides the same function. 

 

Help Function 
An integrated subject related help file with an index and a list of 
keyboard shortcuts for easy operation is available. The keyboard 
shortcut F1 provides the same function. 

1.5 Windows displayed in the S7 Workplace. 

As soon as a window is opened in the workplace (see chapter 1.4 –
“View” menu) an additional Toolbar is opened. The icons displayed 
depend on the window opened. 

The tool bar II provides instant access to frequently used commands. 
Click an icon with the mouse and the command is executed. With the 
keyboard you can reach these functions via the File menu and the 
Block menu. The icons of currently usable commands are displayed 
in full colors. Inactive ones are in light grey. 

Tool bar II   (Offline) 

 
 

Tool bar II   (Online) 
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Tool bar II  
          (Module, Automatic Troubleshooting, Symbolic Table, Force Values) 

 

 

SET 
A marked Operand will be “Set”. A logical one (1) 
is introduced to the marked bit. The next PLC cycle overwrites 
the set bit with the actual RLO. The user program may also 
modify the Operand. 

 

RESET 
A marked Operand will be “Reset”. A logical 
zero (0) is introduced to the marked bit. The next PLC cycle 
overwrites the set bit with the actual RLO. The user program may 
also modify the Operand. 

 

Change Value 
The change value dialog box 
will be opened to display and 
modify process variables. The next PLC cycle overwrites the 
change value with the actual RLO. The user program may also 
modify the Operand. 

 

Force to 1 – SET 
A marked Operand will be “Forced to 1”. A logical 
one (1) is introduced to the marked bit. A forced value of “1” 
cannot be overwritten by the actual stage of the RLO or the user 
program. 

 

Force to 0 – RESET 
A marked Operand will be “Forced to 0”. A logical 
zero (0) is introduced to the marked bit. A forced value of “0” 
cannot be overwritten by the actual stage of the RLO or the user 
program. 

 

Force Value 
The change value dialog box will be opened to 
display and modify process variables. A forced value cannot be 
overwritten by the actual stage of the RLO or the user program. 

 

Switch of Forcing 
The forcing of the marked Operand will be 
switched off. The RLO and / or the user program takes control 
over the marked Operand. 
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Find the most likely reasons 
for this Signal State 
S7 for Windows® provides an 
Option to trace back an Output Signal (Q, PQ) or a Memory 
Signal (M) to the source Signals. 

 

Show the Module State 
of the Connected PLC 
This icon enables you to 
view the program interrupt information stored in the PLC (I-
Stack, B-Stack, Diagnostic Buffer). The information is displayed 
in real language with the faulty portion of the program. 

 

Show Current Values 
This icon is provided to activate the status 
display. Clicking the icon again will deactivate the status again. 

 

Show Cross Reference 
List for this Operand 
The Cross Reference is 
opened and displays a list where the marked operand is used in 
the PLC program. 

Tool bar II   (PC Block List) 

 

Tool bar II   (PLC Block List) 

 

 

Create new PLC Block 
A dialog box to establish the name of the 
new block is opened. After entering the new Block, the Block 
Editor window is opened and ready for creating a new Block. 

 

Edit Block 
The block selected in the block 
listing will be displayed in the block 
editor and is ready for any changes.  
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Print Block 
The marked block is printed. 

 

Transfer Block to PLC 
The marked blocks are 
transferred to the PLC.  

 

Transfer Block to PC 
The marked blocks are transferred to 
the PC.  

 

PLC Block Compare 
The marked Block from the PC 
Block List is compared with the Block in the PLC (online and 
offline compare). 

 

Cut Block 
The marked blocks are transferred to a temporary 
buffer and are removed from the Block List. The 
keyboard shortcut Ctrl+X provides the same function. 

 

Copy Block 
The marked blocks are 
transferred to a temporary 
buffer and remain in the Block List. The keyboard shortcut Ctrl+C 
provides the same function. 

 

Paste Block 
The blocks currently in the temporary buffer are 
transferred to the PC block list. The blocks 
remain in the temporary buffer. The keyboard shortcut Ctrl+V 
provides the same function. 

1.6 Generating an S7 Project 

A new S7 Project can only be generated in an existing Folder.  
S7 for Windows® provides a command to generate a “New Folder”. 

It is not recommended that you generate a new project directly in the 
“My Documents” folder. You can name a new folder and put it in the 
“My Documents” folder, for instance “S7 Projects”.   
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Generate a new “S7 Projects” folder 

 

 

 

Note: 
To “debug” a PLC program located in the PLC, you have to have the 
PLC program located in a S7 Project. This could be the original project 
with comments and symbols (preferable).  

If the original project is not available you must download the PLC 
program into a newly generated S7 Project. 

Note: 
Windows with “Offline – information” have a light yellow background. 

Note: 
Windows with “Online – information” have a light green background. 
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Commands to open a new project 

S7 for Windows® provides the possibility to generate S7 projects in 
the same format than the SIEMENS® STEP® 7 projects.  

This way import and export functions are not required with  
S7 for Windows®. 

The following explains the steps to generate of a “New STEP® 7 
project”. 

• Open the “Offline” window. 

 

• Click the folder with the right mouse button to open the 
context menu to select the “New STEP® 7 project 
command. 

 

• Type the Project Name “Example 1” in the “Create new 
STEP®7 project” dialog box and confirm with “OK”.. 
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In the Folder “S7 Project” the STEP® 7 Project “Example 1” is 
generated. 

 

• Click the “S7 Project Example 1” with the right mouse button 
to open the context menu. 

 

o Delete This command deletes the STEP® 7 Project. 

o Archive With this command the STEP® 7 Project is 
archived. In the opened dialog box the archive name (file 
name) and the archive location (path, folder) is packed in 
the ZIP format. 

o Properties In the opened dialog box the STEP® 7 Project 
name can be changed. An author name and comments can 
be added. 
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• The “New” command opens dialog box to select containers 
for the CPU and / or the S7 program logic. 

 

• SIMATIC 400 station    
The container will house the complete hardware 
configuration of a PLC with a Simatic 400 CPU. 

• SIMATIC 300 station              
The container will house the complete hardware 
configuration of a PLC with a Simatic 300 CPU. 

• IBH S7-xxx  
The container will house the complete hardware / software 
configuration of a Hardware / Software PLC compatible with 
a Simatic 300 or 400 CPU. 

• S7 Program        
    
The container will house the PLC-blocks of an S7 PLC 
Program. 

A STEP® 7 Project can contain multiple containers. As soon as a 
SIMATIC station or an IBH S7-xxx station is selected a S7 Program 
container is automatically inserted. 

• If you want to transfer a PLC program from a S7 300 CPU 
click “SIMATIC 300 station”. If the PLC you want to work 
with has a S7 400 CPU click “SIMATIC 400 station”. 

The S7 project with its name “Example 1” with the selected 
containers is listed in the “Offline – Tree”.  

 

Note: 
A STEP® 7 Project can hold multiple S7 programs and S7 stations. 
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• Click the tab “Offline” to display the contents of the STEP® 7 
Project. If multiple containers are entered into the STEP® 7 
Project they are automatically numbered. 

 

• If the “Offline” tab is not shown, use the command “Offline 
tree” from the “View” menu to open the Offline window. 

 
 

It is recommended that you use the “Auto 
Hide” icon to lock the tab at the outside border 
of S7 for Windows®. By moving the mouse 
pointer to the tab the window will open 
automatically.  



 Chapter 1 S7 for Windows® Basics Page  18  

      

TTI   Trans Tech International© 2011  STEP® 7   S7 for Windows®   Training 
 

 

1.7 Selecting the English Mnemonics 

 

In the USA, PLC programs usually use English Mnemonics. 
The selection changes the mnemonics of the instructions (key 
words), of the operands in the logic and the symbolic table. The 
selection will not change the language of the program (menu 
commands, symbols, comments, etc.). 

The mnemonics to identify Bit-Memory, Timers, Counters, Inputs, 
Outputs, and the instruction set used for Statement List (STL) 
programming are identified with their English (International 
mnemonics) syntax. 

Examples: 

Input I Timer T OR O 
Output Q Counter C Count Down CD 
Memory M AND A Count Up CU 

Note: 
A “Project” is required to make a PLC user program. You also must 
have an open project to transfer and save an existing program from a 
PLC for backup purposes. 
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1.8 File Menu  

The commands in the File Menu control the opening and saving of 
projects (files). Your personnel preference settings as well as the 
printing and documentation layouts are also controlled by the 
commands from this menu. Basic online debug functions are also 
available. 
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New (New Project) 

 
 

The New command is used to create a new project. An additional 
menu is opened to select the type of project (see Chapter 1.6 
Generating a S7 Project). 
A dialog box will be opened to enter the name of the new project and 
to select the path (folder) to store the project. 

Open 

 

The Open command is used to open a PLC program in a project or a 
file containing a S5 program, a symbolic table (S5 or S7), or a 
hardware configuration (s7) direct. An additional menu is opened to 
select the type of project or a file to open.  
A dialog box will be opened to select the path (folder) the name of 
the project and the PLC Program to be opened.  
If you selected to open a file a dialog box will be opened to select the 
path (folder) the name of the file. Only files with the corresponding 
the file name extension ( .S5;  .SEQ;  .CF7 ) will be listed. 

Save as 

 

The Save as command is used to save the in the “Offline Tree” 
marked Project (the PLC Blocks of the Project are listed in the “PC 
Block List). An additional menu is opened to select the type of project 
to be saved. A dialog box will open to define the name and path to 
save the project. 
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Export STL source 

 

The structure of the STL Source (Source Text) is based on the  
IEC 1131 standard. The S7 Program to export must be selected in 
the “Offline Tree”. The PLC Blocks of the S7 Project are listed in the 
“PC Block List) are converted in the STL Source format and are 
saved in a file with the file extension *.awl. 
STL Source Code (Text) can be modified with any text editor 
(Notepad etc.). This might be necessary to add “Know-How 
Protection” to a S7 Block. 

Import STL source 

 

The S7 Blocks located in a file in the STL Source format with the file 
extension *.awl can be imported to an S7 Program. The S7 Program 
to import to must be selected in the “Offline Tree”. The S7 Blocks are 
added to the S7 Blocks in the PC Block List. During the import the 
Block is automatically compiled into Statement List (STL). 
A dialog box opens if the Block to be imported is already present in 
the S7 program listed in the PC Block List. 

 

Click the Yes button to overwrite the PLC block listed in 
the dialog box only. If another block is imported the 
dialog box will be opened again. 

Click the No button to not be overwrite the block listed  
in the dialog box. The original block remains untouched. 
If another block is imported, the dialog box will be opened again. 

Click the All button to overwrite the PLC block listed in 
the dialog box. Any further block to be imported will also 
be overwritten. The dialog box will not be opened again. 

Click the Cancel button will abort the block import. The 
PLC block listed in the dialog box and any further block 
to be imported will not be imported. The dialog box will not be 
opened again.  
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Export Symbolic File 

 

The symbolic table of the PLC program can be exported in plain text 
format (ASCII Text). The S7 Program must be selected in the “Offline 
Tree”. In the opened dialog box you have to select the path (folder) 
and to enter the name of the symbolic file to be exported. The 
symbolic table file is saved with the file name extension .seq.  

To display the Symbolic File to be exported 
click the “Edit Symbolic Table” icon. 

 

Import Symbolic File 

 

A symbolic table located in a file in plain text format (ASCII Text) with 
the file name extension .seq can be imported. The symbolic table is 
added to the program. The S7 Program must be selected in the 
“Offline Tree”.  

 

With this command you may only open files in the symbolic table file 
format (*.seq). 

Save Online Blocks 

 

The PLC Block in the connected online PLC can be saved in an 
archive file (compressed format). A dialog box is opened where you 
can select the Archive Name and the path to save the archived PLC 
program. This command is used to backup PLC programs and save 
the different versions (Backup History).  

Note: 
Any in the PLC existing symbolic table is overwritten. After the import 
only the imported symbolic table is available in the PLC program. 
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Restore Online Blocks 

 

The archived PLC Programs saved in the PC (different versions – 
backup History) are listed. The marked archived PLC Program can 
be transferred to the connected online PLC. This program will 
replace PLC program inside the PLC. 

Restore Online Blocks 
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Transfer Project to the PLC 

 

The PLC Program marked in the “Offline Tree” is transferred to the 
connected online PLC. 

 

Prior to overwriting a Block a warning is displayed to allow or cancel 
the overwriting. 

Compress PLC Memory 

 

Deleting blocks in the PLC does not remove these blocks from the 
PLC memory. The deleted blocks still occupy space in the memory. If 
blocks with the same name are transferred to the PLC, the old block 
remains in the PLC and occupies space in the PLC memory. The 
command Compress, from the File menu, reorganizes the PLC 
memory. All the unused blocks are deleted. After executing this 
command, only usable blocks remain in the PLC memory. 

Clear / Reset PLC 

 
 

Click the command “Clear / Reset PLC” in the File menu. 

Overall Reset; Erasing the Program Memory and Resetting the CPU 
Before downloading a new program to the S7 programmable 
controller (PLC) a memory reset on the CPU should be performed to 
ensure that no "old" blocks and information are still in the CPU. 
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Overall Reset deletes the following: 
A memory reset clears the following data from the selected module: 

• Work memory  

• Read/write area of the load memory  
If a memory card is inserted, the module copies the contents 
of the memory card to the internal load memory following the 
memory reset. 

• System memory 

• Backup memory 
The S7 MPI parameters and the diagnostic buffer are not 
changed. 

To ensure that the command “Clear / Reset PLC” is not accidentally 
executed a warning is displayed. Confirm the warning. 

 

If the CPU is not in the Stop mode a message is displayed and the 
command “Clear / Reset PLC” will not be executed. 

 

Copy from RAM to ROM 

 
 

Click this command to copy the contents of the RAM of the active 
module to the ROM area (only modules which support this function). 

PLC State 

 
 

Several displays are provided to display the status of the online PLC. 
If the PLC is running only the common information the S7 Diagnostic 
Buffer and the S7 memory usage display are available. 

If the PLC is in a stop due to a fault condition, the Interrupt Stack (I-
Stack) and the Block Stack (B-Stack) will display the reasons for the 
stop condition.  
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Common Information 

 

The "Module Information" property sheet contains detailed diagnostic 
and maintenance information on the module. Depending on the 
diagnostics capability of the module, different information is available. 

Interrupt Stack (I Stack) 
Clicking the “Interrupt Stack” tab opens the interrupt stack (I stack). 
The interrupt stack always refers to a priority class. First the 
respective organization block must be marked (selected) in the B 
stack. 

The data displayed is valid for the interrupted priority class assigned 
to the organization block (OB) selected in the block stack.  
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RUN 
If the PLC is in a STOP condition. Click RUN to put the PLC into the 
RUN condition. Start with the execution of OB100. 

Restart 
If the PLC is in a STOP condition. Click Restart to put the 
PLC into the RUN condition. Start with the execution of 
OB101 / OB102 (CPU 400 only). 

STOP 
The PLC is in a RUN condition. Clicking STOP to put the PLC into a 
STOP condition. 

Register (ACCU's) 
The contents of accumulators 1, 2, 
3, and 4 are displayed in 
hexadecimal form.  

Block and Segment 
The block and the Segment where the 
PLC program was interrupted (stop 
condition) is displayed. 

Data Blocks 
The active data blocks (DB) are listed 
when the PLC program was interrupted, 
the data block numbers will be 
displayed. 

Status 
Status Word Bits: 
The bits zero to eight 
of the status word are 
also displayed and given an abbreviation for their meaning (bit 9 … 
15 unassigned). 

Assignment Bit Description 

BR 8 Binary Result 

The BR bit is used to indicate whether 
or not an error occurred during the 
execution of an SFB or SFC.  
 If an error occurred the BR bit is 0 
 If no error occurred the BR bit is 1 
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Status Word Bits (continued) 

Assignment Bit Description 

CC 1, CC 0 7, 6 Condition Code 1 
Condition Code 0 

The CC1 and the CC0 bits provides 
information about the results of 
various operations: 
 Results of a math instruction 
 Results of a shift or rotate 
 instruction 
 Results of a comparison instruction 
 Results of a word logic instruction 

OV 5 Overflow 

The OV bit is set if an error occurred 
during an arithmetic function, math 
function or compare function.  
The OV bit is reset if the fault is 
cleared. 

OS 4 Stored Overflow 

The OS bit is set together with the OV 
bit but is not reset if the fault is 
eliminated.  
The bit can be reset with the Jump if 
OS=1 (JOS), the block call, or the 
block end commands. 

OR 3 Or  
(AND before OR) 

The OR bit is used during the 
execution of a logical AND instruction 
(A, AN, A(, AN(,)and NOT) prior the 
OR operation.  
If the RLO of the logical AND 
instruction a "1", the OR bit is set. Any 
other logical bit instruction resets the 
OR bit. 

STA 2 Status The STA bit stores the value of the 
addressed (referenced) bit. 

 RLO 1 
Result of Logic 
Operation 
(previous) 

The RLO bit stores the result of a 
logical operation triggered by a bit 
logic instruction or math comparing 
instructions. 

/FC 0 First Check Bit 
(negated) 

The value of the FC bit is used to 
control chained logical and compare 
instruction. 

Portion of Erroneous Block 

 
A list field is provided to display the portion of the PLC where the 
fault occurred.   



 Chapter 1 S7 for Windows® Basics Page  29  

      

TTI   Trans Tech International© 2011  STEP® 7   S7 for Windows®   Training 
 

Block Stack (B-Stack) 
During the program execution the jump instructions enter data in the 
block stack. The block where the jump (block call) originated and the 
following locations are listed. The block stack lists all the blocks that 
that were called but had not been completely processed prior to the 
CPU going into its STOP mode. 

 

Details are displayed about the selected block (segment). Mark the 
Block that you want details on. 

L-STACK 
The data in the L-Stack (local Temp data) can 
be displayed. Select the Block and click the “LSTACK” button. 
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S7 Memory usage 
The used memory with its absolute addressing is displayed.  

 

A button is provided to compress the memory. 

Performance Data 
The types and amounts of operands, the types Organization Blocks 
and their numbers, and the System Blocks (SFC, SFB) the CPU can 
perform are listed. 
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Cycle Time 
The preset maximum Cycle Time (Hardware Configurator) and the 
actual cycle times (shortest, current / last, and the longest) are listed. 

 

Time System 
The parameters of the time settings of the CPU are displayed. 

 

PLC Access Permission 

 

The “SETUP” command opens a dialog box to assign a password to 
access an online connected PLC. With the “Cancel” command the 
access can be permitted. Not all CPUs support this function.  
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Memory Card File 

 

The "Memory Card file New…" and "Memory Card file Open…" 
functions can be used to save a full set of data from a project to a 
memory card along with any other data desired.  

This data can then be retrieved from the memory card for 
subsequent use. In addition, you have the option of saving the 
current user program (including the HW configuration) to the memory 
card. To save or retrieve data, the memory card can be located either 
in a CPU or in the slot of a programming device (PG) or PC. The 
"New…/Open… Data on Memory Card" functions are only available 
for newer CPUs. 

Preferences 

 

The Preferences command or clicking the icon opens the 
Preferences dialog box. 

The dialog box is designed as a card file with tabs to separate the 
different subjects.  

Each dialog box card offers buttons and command fields to setup the 
appearance of S7 for Windows®. 

Block View Tab 

  



 Chapter 1 S7 for Windows® Basics Page  33  

      

TTI   Trans Tech International© 2011  STEP® 7   S7 for Windows®   Training 
 

Mnemonics 
The language of the mnemonics you 
want to use can be set. The selection 
changes the mnemonics of the 
instructions (key words) and the operands in the logic and the 
symbolic table. The selection will not change the language of the 
program (menu commands, symbols, comments, etc.). 

English Mnemonics (normally ON) 
The mnemonics to identify Bit-Memory, Timers, Counters, Inputs, 
Outputs, and the instruction set used for Statement List (STL) 
programming is identified with their English (International 
mnemonics) syntax. 

Mnemonics  Mnemonics 
Name English German  Name English German 
Input I E  Counter C Z 

Output Q A  AND A U 
Memory 
(Flag) 

M M  Count 
Down 

CD ZR 

Timer T T  OR O O 
 

Column Width (normally set as shown) 
S7 for Windows® can display a symbolic 
operand with up to 24 characters (without a 
hyphen). To display symbolic operands with 
their full length name, the column width is 
adjustable. It is insured, that the operand is 
correctly identified even when the symbolic 
name is truncated in the display.  

The column width can be adjusted automatically or set manually. 

The column width is separately adjustable for the Control System 
Flowchart (CSF) and the Ladder Diagram (LAD) display. You can 
select a column width between 10 and 26 characters (including the 
leading hyphen) for the CSF display. LAD display allows a column 
width between 12 and 28 characters (including the leading hyphen). 

The number entered as the column width is the number of characters 
spaces possible to display. The width of a character space varies 
with the font selected and does not always match the width of the 
other characters. Usually the number of space characters is slightly 
higher than the number of characters possible to be displayed in a 
given column width.  
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Column width example S7 for Windows® 

   
 

 

Adjust automatically (normally ON) 
The column width of each segment is adjusted automatically to the 
width of the used operands.  

Status Values 
Address (normally ON) 

In this column the memory address of the 
S7 instruction is displayed. The address 
displayed in the STL Status window online, 
is the relative addresses within the PLC 
RAM area. 

RLO (normally ON) 
In this column the Result of a Logical 
Instruction (ROL) of the instruction ,in that 
specific line, is displayed. 

Contents (normally ON) 
In this column the Status Bit or the Contents of counters and timers is 
displayed. 

ACCU1, ACCU2 (normally ON) 
In these columns the contents of the Accumulators is displayed. The 
accumulators are 16 or 32 bit general purpose registers and are used 
to process bytes, words, and double words. 

Status Word (normally ON) 
In this column, the contents of the Status Word is displayed. The 
eight (8) lower bits of the 16 bit Status Word Register are showing 
detailed information about the instruction.  
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Address Register 1, Address Register 2 (normally OFF) 
The contents of the Address Registers are displayed in these 
columns.  

DB Register 1, DB Register 2 (normally OFF) 
The contents of the Data Block Registers are displayed in these 
columns.  

Indirect Address (normally OFF) 
In this column the information about the indirect addressing in use is 
displayed. 

Display Status after Cursor (normally ON) 
When selected, the status is only shown starting at the cursor 
position down to the end of the status window. This reduce the 
number of lines to be display with their status. This will give a faster 
status update. 

 
 

Show information (normally ON) 

 

If selected additional information are shown. 
 

Background Color (normally Offline light yellow, Online light green) 
The default setting is that Windows 
with “Offline – information” has a 
light yellow background. Windows 
with “Online – information” has a 
light green background. 

The color of the background can be changed. Clicking the 
button will open a dialog box to change the colors. 
 

S5 Status – One Network in Status Only (normally OFF) 
When selected, the status is only 
shown for one network (segment). 
This reduces the amount to be 
displayed with their status. This will allow a faster status update.  

Note: 
The more information you want to display in the STL Status window the 
longer it takes to build up the STL Status window. All information being 
displayed has to be transferred from the PLC to the PC. 



 Chapter 1 S7 for Windows® Basics Page  36  

      

TTI   Trans Tech International© 2011  STEP® 7   S7 for Windows®   Training 
 

S5 Status – Fast Status (normally OFF) 
S5 / S7 for Windows normally fetches at least one complete network 
(segment) of a PLC Block for the status display in STL presentation. 
This has the advantage that all parts of the segment being executed 
and the parts being jumped over (light gray) are displayed. There is 
the possibility when using conditional jumps in the PLC program, that 
the status display will requires some time to build the display. When 
selected, the data from the PLC is manipulated to display logic that is 
called very seldom, so the system will run faster. This will reduce the 
amount of logic (lines) displayed with their status. 
 

CPU Load on Status (normally set to High) 
The Status Display requires a lot of data 
to be transferred between the PLC and 
the PC to update the segment (network) 
displayed on the monitor. This data transfer puts a lot of load on the 
CPU of the PC. A slider is provided to adjust the allowable load due 
to the data transfer on the CPU.  
If the keyboard or mouse handling feels slushy (slow PC, fast PLC 
action) reduce the CPU lode.  

Fonts Tab 

 
 

The font can be changed. Clicking the button will open a 
dialog box to change the fonts.  
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Different fonts may be assigned to various subjects for separation 
and a better reading. Also the font size and its style may be set. 

 

 
 

Write Protect Tab (normally set as shown) 

With S7 for Windows® you can prohibit the online access to the PLC. 
The access can be password protected. If a password is assigned it 
is not possible to change the settings of this page. 

  

Note: 
The font selection (done via the Presentation Fonts settings) is for the 
CRT display only. The fonts for the documentation printout are selected 
with the settings from the Font Type card of the Documentation Layout 
dialog box. 
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Block List Tab (normally set as shown) 

 
 

S5 displayed elements – Offline  
The settings are used to select 
the data to be displayed in the 
PC Block List. For each 
element selected a column will 
be reserved to display the 
appropriate data.  

Also STEP 5 Comment Blocks 
can be displayed in the PC 
Block List if selected. 
 

Format (normally OFF) 
The editor integrated in the  
S5 / S7 for Windows® package "understands" the syntax of 
STEP® 7 and STEP® 5 PLC Blocks. The current syntax format of a 
PLC Block (S5 or S7) is displayed in the column Format. This column 
should only be activated when both options S5 for Windows® and  
S7 for Windows® are installed and a PLC program with both (S5 and 
S7) Blocks are present. 

Symbol (normally ON) 
It is possible to assign a name (Symbol) to a PLC Block in the 
Symbolic Table. If a Symbol is marked, the a name (Symbol) of the 
PLC Block is displayed in the symbol column of the PC Block List.  
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Length (normally ON) 
The column displays the length of the PLC Block in bytes. 

Date (normally ON) 
The column displays the date and time the PLC Block was created or 
modified.  

The date information is only available if the PLC Program is stored in 
the S5 for Windows format. If a PLC program is stored in the 
SIEMENS S5 format Block Dates are not supported. The SIEMENS 
S5 format supports only supports the date of the PLC program file 
(DOS date). This date is then the PLC Block date (all Blocks have 
the same date).  

Comment (normally ON) 
The column displays the PLC Block comment in the PC Block List. 
The comment displayed is assigned to a Block in the Block 
Properties dialog box. 

Library Number (normally OFF) 
A library number to the assign block may be displayed. The library 
number is a five (5) digit identification number and can be saved in 
the PLC. Original SIEMENS blocks usually have library number 
assigned. The library number is assigned to an S5 Block via the 
Block Properties dialog box. Only S5 Blocks can have library 
numbers. 

Function Name (normally OFF) 
The column displays the name of the Function Blocks (FB, FX) being 
present in the S5 format. Function names are not available with S7 
Blocks. 

STEP 5 Comment Blocks (normally OFF) 
STEP 5 allows the presents of PLC Blocks containing Comments 
only. These Comment Blocks can be listed in the PC Block List. 

S5 displayed elements – Online  
The settings are used to select the 
data to be displayed in the PLC Block 
List. For each element selected a 
column will be reserved to display the 
appropriate data. Some of the 
elements marked in the dialog box are not stored in the PLC 
memory. If this information is displayed it is based on information 
stored in the PLC Preprogram stored in the PC.  
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Address (normally ON)  
The address displayed in the PLC Block List online is the absolute 
address within the PLC Memory. The addresses change whenever 
additional Blocks are loaded into the PLC. 

Symbol (normally OFF) 
It is possible to assign a name (Symbol) to a PLC Block in the 
Symbolic Table. If Symbol is marked the name (Symbol) of the PLC 
Block is displayed in the symbol column of the PLC Block List. The 
name (Symbol) is not stored in the PLC memory. 

Library Number (normally OFF) 
A library number to the assign block may be displayed. The library 
number is a five (5) digit identification number and can be saved in 
the PLC. Original SIEMENS blocks usually have library number 
assigned. The library number is assigned to an S5 Block via the 
Block Properties dialog box. Only S5 Blocks can have library 
numbers. 

Function Name (normally OFF) 
The column displays the name of the Function Blocks (FB, FX) being 
present in the S5 format. If Function Name is marked the name 
(Symbol) of the PLC Block is displayed in the Function Name column 
of the PLC Block List. The name (Symbol) is not stored in the PLC 
memory. 
Function names are not available with S7 Blocks. 
 

S7 displayed elements – Offline  
The settings are used to select the 
data to be displayed in the PC 
Block List and the PLC Block List. 
For each name selected a column 
will be reserved to display the 
appropriate data.  
 

Format (normally OFF) 
The editor integrated in the S5 / S7 for Windows® package 
"understands" the syntax of STEP® 7 and STEP® 5 PLC Blocks. 
The current syntax format of a PLC Block (S5 or S7) is displayed in 
the column Format. This column should only be activated when both 
options S5 for Windows® and S7 for Windows® are installed and a 
PLC program with both (S5 and S7) Blocks are present.  
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Symbol (normally ON) 
It is possible to assign a name (Symbol) to a PLC Block in the 
Symbolic Table. If Symbol is marked, then a name (Symbol) of the 
PLC Block is displayed in the symbol column of the PLC Block List. 
 

Length (normally ON) 
The column displays the length of the PLC Block in byte. 
 

Date (normally ON) 
The column displays the date and time the PLC Block was created or 
modified.  
 

Comment (normally ON) 
The column displays the PLC Block title or the comment in the PC 
Block List. If a title is assigned in the title bar of the Block this 
information has priority. The title is also displayed in the Block 
Properties dialog box. The Block comment is assigned in the 
symbolic table. 
 

Name (normally OFF) 
The column displays the name of S7 Block assigned to the Block in 
the Block Properties dialog box. The name is part of the PLC Block 
Header and is stored with the Block in the load memory of the PLC. 
 

Family (normally OFF) 
The column displays the name of family that the S7 Block belongs to. 
It is assigned to the Block in the Block Properties dialog box. The 
family name is part of the PLC Block Header and is stored with the 
Block in the load memory of the PLC. 
 

Author (normally OFF) 
The column displays the name of author of the S7 Block. The author 
has to assign his name to the Block in the Block Properties dialog 
box. The author name is part of the PLC Block Header and is stored 
with the Block in the load memory of the PLC. 
 

Version (normally OFF) 
The column displays the version number of the S7 Block. The author 
has to assign the version number to the Block in the Block Properties 
dialog box. The version number is part of the PLC Block Header and 
is stored with the Block in the load memory of the PLC. 
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S7 displayed elements – Online  
Symbol (normally OFF) 

The setting is used to enable the 
data to be displayed in the PLC 
Block List.  

If a name (Symbol) is assigned 
to a PLC Block in the Symbolic 
Table and Symbol is marked the name (Symbol) of the PLC Block is 
displayed in the symbol column of the PLC Block List. The name 
(Symbol) is not stored in the PLC memory. 

The command Print opens the dialog box Print The dialog box gives 
you the ability to select the items to be printed. 

Print 
The Print command opens a dialog box to select the portions of the 
PLC program to be printed.  

 
 

Block List  
If the block list button is marked, a list is printed with the information 
displayed in the PC Block List window with the names of the blocks, 
their length, date and time of the last modification, and the comments 
that will be printed out. 

Blocks 
All Blocks displayed in the PC Block List or a single block can be 
select from the drop down list and be printed.  
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Symbolic Table 
If the symbolic table button is marked, the symbolic table will be 
printed out. 

Used Operands List 
The portions of the Used Operands List to be printed can be 
selected. You may mark one, several, or all operand groups to be 
printed in the used operands list. The used operands list is printed, 
showing the selected operands and where they are used (block and 
segment number) within the PLC program. 

Cross Reference List 
The portions of the Cross Reference List to be printed can be 
selected. You may mark one, several, or all operand groups to be 
printed the cross- reference list. The cross-reference list is printed 
showing the selected operands and where they are used (block and 
segment number) within the PLC program. 

Hardware Configuration 
An overview or the complete Hardware Configuration can be printed .  

Print Settings 
The Print Settings command opens 
the Documentation Layout dialog box. 

The dialog box is designed as a card file with tabs to separate the 
different subjects.  
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Margins Tab (Documentation Layout Dialog Box) 

Select the set margins dialog box to customize the page layout. The 
margins of the Program Text (Main Body – area where the PLC logic 
is printed) and the Footer (Header / Footer) are set independently. 
The dimensions are in centimeters (cm). 

 The measurements must be entered in centimeter (cm). 

 The margins for the header and the footer are measured relative 
to the page. 

 The margins of the main body are measured relative to the 
header and footer (inside). 

Page Layout Margins 

  

Header / Footer Tab (Documentation Layout Dialog Box) 

The tab provides fields to customize the appearance of the page of 
documentation for the PLC program. 

You may type any text in the text fields. There are field abbreviations 
available to assist you when entering PLC program information and 
date and time information to the header and footer. Buttons are 
available to disable the footer or header. The font for the header and 
footer may also be set.  

Main Body

Header / Footer

Header / Footer  

Top

Botton
Left Right

RightLeft

Botton

Top
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Header / Footer Tab 

 
 

Font 
The font can be selected. Clicking the button will open a 
dialog box to change the fonts.  

The font selections made in the Fonts Type settings box, are used for 
printing only. 

Header 
The tab provides a field (you may enable / disable the header) to 
customize the appearance of the page header of documentation for 
the PLC program. You may type any text in the text field. 

Footer 
The tab provides a field (you may enable / disable the footer) to 
customize the appearance of the page footer of documentation for 
the PLC program. 

There are field abbreviations available to assist you when entering 
PLC program information and date and time information to the footer. 
You may type in addition to the abbreviations any text in the text 
field. 

Footer Field abbreviations 
%f File name of the PLC program without file name extension. 

%t List name (Title). 

%p Page number. 
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Footer Field abbreviations (Continued) 

%a Day   Printing date  
%b Month   Printing date. 
%c Year   Printing date. 
%d Day   File creation/modification date. 
%m Month   File creation/modification date. 
%y Year   File creation/modification date. 
%h Hour   File creation/modification date. 
%I Minutes   File creation/modification date. 
%s Seconds  File creation/modification date. 

Connect to the last PLC selected 

 

The last selected PLC online connection is established again (how to 
select and establish an online PLC connection see chapter 2). 

Close the Connection to the PLC 

 

The PLC online connection is disabled. 

1.9 Find Menu 

The “Find Menu” provides a command to search and replace 
operands or text in the market section of a Block. That section of the 
Block is momentarily displayed in the workplace; a PLC Block, or in 
the entire PLC program. 

 

It is also possible to switch the Block displayed to its next / previous 
window (section to enter text or logic) or to a specified segment.  
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Search For / Replace 

A dialog box is opened 
providing the tools to search for / replace an operand or text within 
the PLC Block or the Current Section or the Selected (marked) Text. 
This feature works when the Block is open in the PC Block List or the 
PLC Block List, and active. 

 

The found operand is highlighted. 

 

A message is displayed if an operand or text was not found. 
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Replace 

 

If “Replace” has been selected, in addition to the highlighted 
operand, a dialog box is opened where you can decide whether or 
not to replace the operand. 

 

If Yes or No is clicked, the next operand is highlighted and the 
“Replace” dialog box is opened for the next decision. 

Search in Program / Replace in Program 

 

A dialog box is opened providing the tools to search / replace an 
operand or text within the whole PLC Program. This feature works 
with the Blocks listed in the PC Block List only. 
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Search in Program 
The result is shown in the “Search result” window. 

 

Replace in Program 
The operand is highlighted. 

 

If “Replace in Program” has been selected, in addition to the 
highlighted operand, a dialog box is opened to decide to replace or 
not the operand. 

 

If Yes or No is clicked the next operand is highlighted and the 
“Replace” dialog box is opened for the next decision.  
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1.10 View Menu 

The “View Menu” provides command to open windows to perform 
additional tasks. 

 

Block Compare 

 

Click the icon to open the Compare window.  
Select the two locations where the files to be compared are located. 

The PLC Programs to be compared could be the program selected in 
the offline tree and the program stored in the PLC selected with the 
online tree or any other PLC Programs stored on the PC. 
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Clicking Compare will open a dialog box to define how the 
comparison should take place. 

 

When comparing a PLC Program on the PC with the Program 
executed on the PLC, only the code is relevant. Mark “Compare 
code”. To start the comparison confirm by clicking the “OK” button. 

 

The compare result is shown in the upper part of the compare 
window. PLC Block names written in black are identical, PLC Block 
names shown in red have differences in the code. 

 

ATTENTION: 
Do not transfer blocks from the PLC to the PC if the selected  
blocks exist in the PC RAM.  
If a block in the PC is overwritten by a PLC block, it is possible 
that comments will be shifted and labels may not be valid anymore 
(labels are exchanged with substitute labels (M001 etc.). 
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Differences in Code 

 

Clicking the Block name opens a window with the details of the 
compared Blocks. Any differences are displayed in red. 
 

 

COM Package 

 

With S5/S7 for Windows it is possible to execute Original Siemens 
S5 – COM-Software Packages. 

The S5 – COM-Software Packages can only be used with special  
S5 Hardware.  

ATTENTION: 
Comparing a PLC Program on the PC with the Program executed 
on the PLC will show (most of the time) differences in  
Data Blocks (DBxx). This is normal if the data stored in the  
Data Block is collected from the PLC. 

In any event the length of the Data Blocks must be identical.  
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1.11 Cross Reference 

S5 / S7 for Windows provides a tool to list 
the operands, their use, and origin. The 
internal cross-reference list is constantly updated. Whenever 
searched for the use of an operand, the displayed list provides the 
current state of the operand in use. 
The Cross Reference command is identical with Search in Program 
command. A click on the command opens a dialog box providing the 
tools to display an operand or text within the whole PLC Program or 
the momentary active PLC Block. This feature works with the Blocks 
listed in the PC Block List only. 

 

Search for 

 

The name of the operand listed in the cross reference can be entered 
in the text field in its symbolic or absolute form (or any text to be 
searched for). 

Enter the name of the operand to be displayed in the cross-reference 
list in the text field. Mark “Find Operand”. Mark the desired buttons 
and confirm by activating the OK button. 
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Overlapped Operands 

When the Overlaid Operands button is marked, the specified bit 
displayed in the cross-reference is listed as a bit and if the bit is 
present in a byte, word, or double word that will also listed. A byte will 
be found in a word or double word and a word will be found in a 
double word. 
If the button is not marked the specified operand will only be found in 
its specified format. 

S7 for Windows can display a cross-reference list for the following 
operands. Absolute operand names can be entered in lower or 
uppercase letters. Spaces are ignored. 
 

Operand The cross reference list displays Example 

* the complete cross reference list * 

B all Blocks B 

C all Counters C 

Cn the specified Counter C12 

D all Data Words D 

DBBn the specified Data Byte in a Data Block DBB12 

DBDn the specified Data Double Word in a DB DBD6 

DBn the specified Data Block (DB) DB5 

DBWn the specified Data Word in a DB DBW23 

DBXn.n the specified Bit in a Data Block DBX12.7 

DIBn the specified Data Byte in a Instance DB DIBn 

DIDn the specified Data Double Word in a 
Instance DB 

DIDn 

DIWn the specified Data Word in a Instance DB DIWn 

DIXn.n the specified Bit in a Instance DB DIXn.n 

FBn the specified Function Block (FB) FB567 

FCn the specified Function (FC) FC890 

I all Inputs I 

IBn the specified Input Byte IB44 

IDn the specified Input Double Word ID24 

In.n the specified Input Bit, also from a Input 
Byte or Input Word 

I34.5 

IWn the specified Input Word IW15 
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Operands possible to be displayed in the S7 cross reference list 
(continued) 

Operand The cross reference list displays Example 

LBn the specified Local Data Byte LB23 

LDn the specified Local Data Double Word LD16 

Ln.n the specified Local Data Bit, also from a 
Local Data Byte or Local Data Word 

L26.7 

LWn the specified Local Data Word LW35 

M all Memory Bits M 

MBn the specified Memory Byte MB34 

MDn the specified Memory Double Word  MD54 

Mn.n the specified Memory Bit, also from a 
Memory Byte or Memory Word 

M56.4 

MWn the specified Memory Word  MW23 

PIBn the specified Peripheral Input Byte (direct 
I/O access) 

PIB123 

PIDn the specified Peripheral Input Double Word 
(direct I/O access) 

PID456 

PIWn the specified Peripheral Input Word (direct 
I/O access) 

PIW246 

PQBn the specified Peripheral Output Byte (direct 
I/O access) 

PQB76 

PQDn the specified Peripheral Output Double 
Word (direct I/O access) 

PQD452 

PQWn the specified Peripheral Output Word (direct 
I/O access) 

PQW346 

Q all Outputs Q 

QBn the specified Output Byte QB487 

QDn the specified Output Double Word QD345 

Qn.n the specified Output Bit, also from a Output 
Byte or Output Word 

Q411.7 

QWn the specified Output Word QW24 

T all Timers T 

Tn the specified Timer T126 
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2 S7 for Windows® Online Functions 

How to troubleshoot an On-Line connection to the PLC  

2.1 Connecting the S7 PLC with a PC 

Programming Unit
PC PLC Control

S7 for
Windows

 

An S7 PLC (one or more) connected to the PC are listed in the 
“Online – Tree”.  

All possible connections are listed. To select a 
connection click the icon in front of the name. The 
established connection is displayed in bold letters. 
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If the “Online” tab is not shown, use the command “Online tree” 
from the “File” menu. 

 

It is recommended that you use the “Auto Hide” icon to lock the tab at 
the outside border of S7 for Windows®. By moving the mouse pointer 
to the tab, the window will automatically open. 

 

S7 SoftPLC internal 

 

An S7 SoftPLC can be installed (optional), on the PC executing S7 
for Windows®, That Software PLC could be used to control 
machinery. Inputs and outputs are handled via a bus system (Profi 
Bus etc.). 

Internal S7 PLC Simulation 

 

S7 for Windows® provides an internal Simulation PLC. With the 
integrated Simulation PLC you can test PLC programs. For testing 
you do not need additional hardware. The programs are tested 
directly within your PC. The status is displayed, you can force inputs, 
and you can display the outputs.   

The internal Simulation PLC is fully compatible with the S7 CPU 416. 
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S7 IBH Link Network 

 

The IBHLink S7 is an Ethernet-converter within a 15-pin Sub-D-
housing for a connection via a switch, a hub or even directly to a PC 
with a common network adaptor. The protocol used is the standard 
TCP/IP protocol. In this way, the user can benefit from all the 
advantages of Ethernet, such as remote maintenance via a standard 
router or VPN-connections (Virtual Private Network). Likewise, a 
direct connection to the Internet is possible.  

S7 CP via TCP/IP; S7 CP via H1 
These connections require “Communication Processer Boards” in the 
PLC. The connections are listed because a standard Ethernet 
connection is required at the PC side. 

Communication Port (COM1) 

 

Selecting the Communications serial ports 
(COM 1 – COM 4) will open a dialog box to 
select the Baud Rate and the Protocol. USB Cables require 
conversion software. 

 



 Chapter 2 S7 for Windows® Online Functions Page  59  

      

TTI   Trans Tech International© 2011  STEP® 7   S7 for Windows®   Training 
 

The Simatic S7 PLC must be connected to one of the serial ports  
(COM 1 – COM 4) of your PC via a MPI Converter Cable.  

Depending on the type (manufacture) the MPI Converter Cable can 
handle Baud Rates of 1920 Baud, 38400 Baud or, 115200 Baud.  

USB Serial Port (COM4) 

 

S7 for Windows® cannot handle an USB Port 
connection directly. To use an USB connector 
cable, software must be installed to convert the 
COM port connection to a USB port. This software driver is provider 
with the USB cable. The following pictures show the correct settings 
of the USB Serial Port conversion. Double click the “USB Serial Port 
(COM3) to open the dialog to set the port parameters. 
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Device Manager Settings (USB – COM conversion) 
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2.2 Transferring all PLC Blocks of a STEP® 7 Program to the 
PLC 

The PLC Blocks of a STEP® 7 Program can be directly transferred to 
the connected PLC. No conversion is necessary.  

Transferring a STEP® 7 Program to the PLC 

The following icon identifies a STEP® 7 Program. PLC 
projects (programs) created with the basic PLC 
programming package STEP® 7 from SIEMENS may be 
directly be transferred to the PLC.  

Open the “Offline – Tree” and click the program name        
with the mouse button. Click the “PC block list” tab. 

 
 

The PC block list window opens. Open the context menu with a right 
click on any of the Block names. With a click on the command 
“Transfer all Blocks to the PLC” the S7 Program is transferred to the 
connected PLC. 
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If a block is currently stored in the PLC, a dialog box will open to 
allow you to overwrite the block or to abort the transfer. 

 

Activating the “Yes” button will only overwrite the PLC block 
mentioned in the dialog box. If another block is stored in the PLC, the 
dialog box will be opened again. 

2.3 Transferring a PLC Program or PLC Blocks to the PC 

To transfer Blocks from the PLC to the PC, an S7 project must be 
available in the PC to store the transferred Blocks. The project must 
be selected prior transferring Blocks to the PC. 

A single Block, several Blocks or all Blocks can be transferred via the 
serial link to the PC. The selected (marked) blocks in the PLC block 
list are transferred to the PC. This can be a single block or multiple 
blocks. 

 

 

Warning: 
You should only transfer blocks from the PLC to the PC if the 
selected blocks do not exist in the PC Block List.  

If a block in the PC is overwritten by a PLC block, it is possible that 
comments will be shifted. Jumps may not be valid anymore and jump 
labels may be exchanged with substitute labels (M001 etc.) and shifted. 

The names of Local Variables are changed into substituted names  
(IN1, OUT2, IN_OUT3, STAT4, TEMP5, etc. 
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Select the Project, the Hardware Station and the S7 Program where 
you want to save the PLC Program (from the online connected PLC). 

 

Please see chapter 1.3, on how to generate a project and an S7-
300/400 Hardware station. Mark the S7 Program folder. 

 

Make sure the PC Block List is empty. 
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Open the PLC Block List 

 

To transfer all PLC Blocks from the PLC to the PC, use the command 
“Transfer all blocks to PC”. Click on one of the marked Blocks with 
the right mouse button. Click “Transfer all blocks to PC”. 

 

All Blocks from the PLC are transferred to the PC and are listed in 
the “PC Block List”. 

If you want to transfer the hardware configuration as well, 
(recommended), click “OK” in the opened information box. 
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The marked Blocks are transferred to the PC and are listed in the 
“PC Block List”. 

 

If you want to transfer one or several blocks to the PC, mark these 
blocks in the PLC Block List and click on one of the marked Blocks 
with the right mouse button. Click “Transfer to PC”.  

 

Instead of using the right mouse button and the command “Transfer 
to PC” you may use the “Transfer to PC” icon. 
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2.4 Trace Back 

S5 / S7 for Windows® has an integrated “Trace Back” function to find 
out why an operand (Output Qx, Peripheral Px, or Memory Flag Mx) 
has a certain signal state ( ON or OFF). 

The Trace Back function is available from the Online and the Offline 
Tree as soon as the status is activated. 

 

Clicking “Trace Back” followed by Outputs, Flag, or Peripherals the 
searchable operands are shown. If a symbol has been assigned to 
an operand in the symbolic table the symbol and its symbol comment 
are displayed as well. 

The state (status) of the listed operands are 
shown as soon as the status is activated by 
clicking the icon “Show Current Values”  

Clicking an operand with the right mouse button will open the context 
menu to activate one of the Trace Back functions.  

The Trace Back is an automated Search-Engine using the cross 
references. It is determined the origin (Source) of a signal. If a signal 
is formed by a logic function, the input operands of this logic function 
are traced back until finally one or more inputs (operands) are found 
causing the state (status) of the operand traced back.  
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Trace Back 

 

The Trace Back algorithm assumes that a function on the system is 
not being executed. This means that an output signal (Output Qx, 
Peripheral Px, or Memory Flag Mx) is missing. 

The cause for not executing the function is not the missing output 
signal, but that one or more input signals of a logical connection are 
missing. 

Because such a logical connection chains can be very complex, is 
not expected that the cause is always found by the Trace Back 
function. 

Each Trace Back step displays the causes 
found (missing operand). The state (status) of 
the operands can be displayed by clicking the icon “Show Current 
Values”. The forced setting or resetting of the operand by clicking 
with the right mouse is possible (context menu). Also the next trace 
back step can be initiated. With a double click the PLC Block editor 
will open.  
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S5 / S7 for Windows® offers two algorithms to execute the “Trace 
Back” function. 

Find the Most Likely Reasons for this Signal State 

 

Clicking this command will activate the trace back function with an 
algorithm, which takes not all but the most likely possibilities into 
account to find the reason for the output signal state. This algorithm 
often gives a fast result. This traceability is advantageous especially 
for simple logical connections. 

Find all the Reasons for this Signal State 

 

Clicking this command will activate the trace back function with an 
algorithm, which takes all possibilities into account to find the reason 
of the output signal state. 

Example: 
The output signal Q0.0 – On_Seg_A  –  Energize Segment A –  
should be traced back to find the reason of its state (currently “0”). 

 

1. Mark the operand to be traced back. Open the context menu 
with a right mouse click and click the command “Find most 
likely reasons for this signal state”. 

2. The window “Automatic troubleshooting Q 0.0” opens 
automatically and lists the operands (I 0.7) which causes the 
output Q 0.0 to have its signal state. Clicking the icon 
“Show Current Values” to show the status of output  
Q 0.0. 

3. Double-click the line of the operand (I 0.7) to open the PLC 
Block Editor. 

4. Clicking the icon “Show Current Values” to show the 
status of the opened segment. 

5. The "status" (content) of the operand is  I 0.7 is "0". 

6. By using the "Forcing" function the state of the operand I 0.7 
can be changed. To do this, the window “Automatic 
troubleshooting Q 0.0” has to be opened again by clicking the 
tab “Automatic troubleshooting Q 0.0”. 
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7. Mark the line of the operand (I 0.7), Click the icon “Show 
Current Values” and by clicking the button "Force to 1" the 
state of input  I0.7 changes to “1” (Set). 

8. Open the "Offline – tree" window to check the state of the 
output Q0.0. It should be “On” (Q0.0 = 1) 

 

Display the Operands Affecting an Output Signal 
In addition to the automatic “Trace Back” of output signals there is 
the possibility to display the state (status) of all operands that can 
affect an output (output, flags or periphery). 

By clicking on the "+" symbols in front of the output signal 
and the following PLC Blocks / networks the operands 
belonging to this logic are displayed. Also if the icon “Show Current 
Values” has been clicked the status of all the operands belonging to 
the logic will be shown. Operands with the State of "1" will have a 
green background. 

The context menu is opened by a right mouse click on an operand. In 
addition to the “Trace Back” the signal state of the operands can be 
changed by using the “Set / Reset” or the “Force” functions. 

Set (set signal state to 1) 
An operand is selected, the State (status) of the operand is set to "1" 
is set by clicking on the "Set" command (set bit). This "set" is made 
before the first command in the OB1 is processed (start of cycle). 
This State remains until the operand of the program is overwritten. 
The marked operand is an input signal (In.n), the State is overridden 
by cyclic reading of inputs with the start of the next cycle. 

Reset (reset signal state to 0) 
An operand is selected, the State (status) of the operand "0" is set by 
clicking on the "Reset" command (bit reset). This "reset" is made 
before the first command in the OB1 is processed (start of cycle). 
This State is unchanged until the operand of the program is 
overwritten. The marked operand is an input signal (In.n), the State is 
overridden by cyclic reading of inputs with the start of the next cycle. 

Note: 
The “Trace Back” function has its limitations when using indirect 
addressing and local variables. 
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Forcing to 1 
By clicking on the command "Forcing to 1" the state (status) of the 
marked operand is set to "1" (bit = 1). This "set" is made before the 
first command in the OB1 is processed (start of cycle). This state of 
the operand remains until the command "Forcing out" for these 
selected operands.  

 

Forcing to 0 
By clicking on the command "Forcing to 0" the state (status) of the 
marked operand is set to "0" (bit = 0). This "set" is made before the 
first command in the OB1 is processed (start of cycle). This state of 
the operand remains until the command "Forcing out" for these 
selected operands.  

 

Forcing Off 
An operand is selected, the operand is released by clicking on the 
command "Forcing out". Or the State of the operand is again 
dependent on the itinerary follows the State of the input signal. 

 

 

  

Note: 
Operands are not used in the program and inputs that have no physical 
mapping (input card not present) keep their State (1 = set or reset = 0), 
until the mode is set to "STOP" the SPS. 

Inputs, outputs and markers can set / reset. 

Attention: 
Special care is necessary when "Forcing" or "Set". 
Unexpected functions can be started! 
Forcing is possible with inputs, outputs and the periphery.  
S7-400 CPUs allow the "forcing" of memory flags. 
Not all CPUs allow the "forcing". 
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2.5 Oscilloscope 

S5 / S7 for Windows® has a built in oscilloscope to 
monitor the response time of signals (operands / 
variables) present in the PLC.   

There are two (2) channels available to monitor the 
response time of analog signals.  These signals 
(operands) can be displayed as a 32 bit floating point values (REAL) 
or as a16 bit or 32 bit fixed point (integer [INT] or double integer 
[DINT]) or as an absolute decimal (unsigned) value. 

In addition, six (6) channels are also available to the monitor digital 
signals. All types of Bit Operands can be used for monitoring. 

Temporary local variable cannot be monitored. 

 
 

Time base of the Oscilloscope 

The time base can be adjusted 
from 0.2 sec / div up to 200 
sec / div with the mouse. 
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Analog Channel Setup 
 

 

With the “Probe” button (on the right), an operand 
(variable) present in the "PLC Block Editor Status 
window" can be assigned to a channel by using the 
"Drag and Drop" function of the mouse. The displayed 
value of the variable is the value displayed in the status. 

The operand (variable) can be assigned to a channel directly. 

Digital Channel Setup 

 

Up to six (6) bit variables (operands) can be monitored. Each of 
these bit variables can be the used to start the monitoring function. 

The variables (operands) you want to monitor can be 
assigned directly or by using the "Drag and Drop" 
function (with the “Probe” Button) in conjunction with the 
"PLC Block Editor Status window". 
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Trigger Setup 

 
 

Oscilloscope settings Save / Load 

The settings of the oscilloscope can be 
stored on disk. To use the oscilloscope 
with the same settings at a later date, 
the settings can reloaded. 
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3 S7 for Windows® Tools to Debug a S7 PLC Program 

Most tools to debug a S7 PLC Program can only be used if the PLC 
Program is present in the online PLC, and also saved in a S7 Project 
on the PC.  

 

3.1 Opening a S7 PLC Program saved in a “S7 Project”  

Open the “Offline – Tree” by pointing at the “Offline” tab.  

 

If the “Offline” tab is not shown, use the command “Offline tree” 
from the “File” menu. 

 

ATTENTION: 
If you don’t have the original PLC program with symbols and  
comments we recommend that you download the PLC  
program to the PC as described in chapter 2. 
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In the “Offline” window select the path and click on the 
icon in front of the project name (S7_User_Proj_US). 

The project files and other tools are shown. 

 

The project name and the S7 Program name (S7 User Prog) with its 
path, is shown. Also the Blocks are listed in the “PC Block List”.  

 

The PLC Program is now open for further use. 



 Chapter 3 S7 for Windows® Tools to Debug a S7 PLC Program Page  76  

      

TTI   Trans Tech International© 2011  STEP® 7   S7 for Windows®   Training 
 

3.2 Comparing the existing Online and Offline PLC Program 
 

 

 

Select the required PLC at the “Offline – Tree” and the PLC to be 
connected to from the “Online – Tree” (see chapter 1). 

 

 

ATTENTION: 
If you are using the original PLC program with symbols and  
comments make sure that the program executed at the PLC 
is identical with the original PLC program you have on the PC. 

Use the “Compare Tool” to verify that the Program on the PC has the 
same code as the PLC program executed at the PLC. 
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Compare Tool 

 

Click the icon to open the Compare window. 

You may select the two locations where the files to be compared are 
located.  

 
 

When comparing a PLC Program on the PC with the Program 
executed on the PLC, only the code is relevant. Mark “Compare code 
only”. To start the comparison confirm by clicking the “Compare” 
button. 

 

The compare result is shown in the upper part of the compare 
window. PLC Block names written in black are identical, PLC Block 
names shown in red have differences in the code.  
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Differences in Code 

 

Clicking the Block name opens a window with the details of the 
compared Blocks. Any differences are displayed in red. 

 

ATTENTION: 
Do not transfer blocks from the PLC to the PC if the selected  
blocks exist in the PC RAM.  
If a block in the PC is overwritten by a PLC block, it is possible 
that comments will be shifted and labels may not be valid anymore 
(labels are exchanged with substitute labels (M001 etc.). 

ATTENTION: 
Comparing a PLC Program on the PC with the Program  
executed on the PLC will show (most of the time)  
differences in Data Blocks (DBxx).  
This is normal if the data stored in the Data Block is collected  
from the PLC. 

In any event the length of the Data Blocks must be identical. 
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3.3 Arranging Window in the Workplace  

Version 6.x of S7 for Windows® has a new concept to open and 
close windows in the workplace.  

You can use the “Auto Hide” icon to lock the tab at the outside border 
of the workplace and by moving the mouse pointer to the tab the 
window will open automatically. 

It is also possible to open the “PC Block List” in the workplace and 
start the “Debug Tools” from there. The “PC Block List” window stays 
open until you close “PC Block List” the window. 

This mode is preferable if you want to change between Blocks being 
displayed online and offline for modifications.  

To work in this “Classic Operator Interface” mode the S7 PLC 
Program must be opened (see chapter 3.1).  

To select the previously described mode, click “Classic operator 
interface” in the “Window” menu. 

 
 
 

PC Block List in “Classic Operator Interface” mode 
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3.4 PLC Block Status display 

To display the PLC status you must open the desired PLC Block with 
the “Editor”. You may open the Editor by double clicking the Block 
name or by marking the Block name and clicking the icon. 

 

The Block may be selected from the “PC Block List” or the “PLC 
Block List”. If you use the “PC Block List” existing symbolic 
comments may be displayed within the status display. 

 

Activating the Status 
An icon is provided to activate the status. Clicking the icon again will 
deactivate the status. 

 

Note: 
We recommend that you select the Block from the “PC Block List”. If 
any modifications are made they are saved in the PC and therefore are 
available the next time the Block is opened.  
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Status Display, Statement List (STL) Presentation 

 

Status Display, Ladder Logic (LAD) Presentation 
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Status Display, Ladder Logic (LAD) Presentation with Symbolic Table 

 

Status Display, Control System Flowchart (CSF) Presentation 
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